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Tip of the Month 

Encrypt Your Email 

 

Worried about those IT guys in your office being able 

to read your personal emails? Next time you are send-

ing a private or personal email through Microsoft Out-

look, encrypt it so only you and your recipient can read 

them. Head to the Tools menu, then click on Options 

and select the Security tab. Enter a password you‘ve 

shared with the recipient and no one, who doesn‘t know 

the password, will be able to open the message.  

 

"Reprinted with permission from Smart Computing. Visit 

www.SmartComputing.com Groups to learn what Smart 

Computing can do for you and your user group!" 

This Month’s Meetings 
 

August 5 at 1 p.m. 

At FFG Community Church 

Photo Editing Workshop 
 

August 15 at 6 p.m. 

At 127 S. Senior Center 

General Meeting 
 

August 20 at 10 a.m. 

At 127 S. Senior Center 

Investment SIG  
 

August 25 at 1 p.m. 

At FFG Community Church 

Photography Club 
 

August Program 

 
"How to Back Up your Important Files" 

 by Alan Baker 
 

The August PPCUG program will be "How to Back 

Up your Important Files" by Alan Baker.  He will 

discuss why you should back up, some tips on man-

aging your files, where some key files are normally 

stored, how to copy files to a CD, to a flash drive or 

to an external hard drive.  Windows Vista will be 

used in the demonstrations, but Windows XP will 

also be discussed.  A handout with Internet refer-

ences for further study and reference will be in-

cluded. 
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“FREE” Table 

We have set up a table at our member meetings to share our 

“extra” goodies with other club members. 

If you have something to give away, bring it in and put it on the 

FREE table.  It’s first come, first served.  If you see something you 

want, help yourself. 

 

Membership Dues and Expiration Dates 

 

Membership dues are $25 a year for a family, $20 a year for an 

individual, and $10 a year for a student 21 years of age or un-

der. Your membership is valid for 12 months from the month 

you join (or renew your membership).  Please pay your dues to 

the treasurer before the last day of your anniversary month. 

Anyone who is 30 days or more in arrears with membership 

dues cannot participate in the door prize drawings. 

 

Corporate memberships are $25 a year for the first two mem-

berships and $10 a year for each additional membership from 

the same company. 

 

Our Club cannot exist without you, the members.  Remember, 

you and  your membership dues are important to keep the club 

functioning! 

 

BOARD OF DIRECTORS DISCLAIMER 

All members of the Plateau PC Users Group are willing to help one 

another in the area of advice and tutorial instruction over the 

phone.  If you should require more involved services or instruction, 

we have a few members who are very knowledgeable in several ar-

eas.  As a responsible consumer, it is up to you to discuss, before 

retaining a member, any and ALL charges for repair services and 

time consuming tutorial activities. 

 

It is not the desire of this Board of Directors to set fees for individu-

als for services rendered, nor the responsibility to intervene between 

members who enter into a contract among themselves 

 

The GAZETTE is published using the following:  Microsoft Word, 

Microsoft Publisher, and Microsoft Windows 98,  The GAZETTE is 

the monthly newsletter of the Plateau PC Users Group.  Material in 

the GAZETTE may be freely used in other user group newsletters if 

credit is given the author and the PPCUG GAZETTE.  PPCUG 

members may place free classified advertising (up to 50 words) in 

the GAZETTE (run time maximum of three months).   

Commercial ads (local advertisers) may be placed at 50 cents per 

line. Graphic ads (camera ready) are as follows:  $25 per 1/4 page, 

$40 per 1/2 page, $75 per full page. 

 

DISCLAIMER:  No warranty, express or implied, is made by 

the PPCUG, the Gazette editorial staff or its contributing edi-

tors.  This extends to all losses incidental or consequential from 

the use or non-use of any information in any issue of the  

GAZETTE. 

 

 
 

 

     

President Steve Rosenstein (931) 742-0151 

Vice-President  Jim Buxton (931) 456-6009  

Treasurer Alan Baker  (931) 788-2201 

Secretary Richard Del Frate (931) 742-0151 

Librarian/

Compliance  

Tony Gradle (931) 742-0151 

           

Past President Carl Nordeen  (931) 456-5597 

Programs Open  

Membership Dolores Crabtree (931) 484-9013 

Publicity MaryAnn Nordeen  (931) 456-5597 

Product Rev. Chair   

Editor Don Lewis (931) 456-5352 

APCUG Rep  Open 

        

 

Equipment Custo-

dian 

Bob Willis (931) 456-6511 

Webmaster Don Lewis (931) 456-5352 

Directors at Large 

Bob Mohar Kay Cargill Gordon Botting 

Bob Willis Don Lewis  Dick Riesz  

Dolores Crabtree   

   

 SIG Leaders   

Pleasant Hill Dick Riesz (931) 277-5642 

Investment Club Bob Mohar  (931) 707-0434  

Photography SIG Jim Mansfield (931) 484-6920 
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 Up Coming Meeting 
 

The next General Meeting of the 

PLATEAU PC USERS GROUP 

 Will be on September 19, 2011 at 6:00 P. M. at 

127 S.  SENIOR CENTER 

 

Program to be determined 

 

New Members  
 

Acquista, Denise 

Pare, Gerald and Denise 

Parrish, Bonnie 

 

 Classes   
 

Please send ideas for new classes to Alan Baker 

( ambaker@citlink.net )  
  

Cool Sites 
 

Windows 8 is  on the way. See a preview of the new 

interface here: 

 

Find.pcworld.com/71921 

 

PCWorld’s August issue has an interesting article on 

PC cleanup utilities. They tested several free pro-

grams like CCleaner, and several paid programs like 

Ashampoo WinOptimizer to see if they really speed 

up your PC as they promise. The findings and their 

recommendations may surprise you. You can find 

the article at this link: 

 

http://tinyurl.com/6gkf8wx 

[Open in new window] 
 
 
 

PPCUG ISP 
 

We wish to thank the following for providing ISP 

connections:  

 

 Frontier for DSL at the 127 Senior Center and 

Fairfield Glade 

 Multipro for dialup at Pleasant Hill 

 PPCUG Website 
 

Visit our website at www.PPCUGinc.com. The Learn-

ing Center class schedule and Gazette are all 

 available on our web site. 
 

Send your comments and suggestions to the  

Webmaster, Don Lewis 

Webmaster@ppcuginc.com  (931) 456-5352 

News of the Special Interest Groups 
 

The PPCUG sponsors several Special Interest Groups 

(SIGs) tailored to meet the varied needs of our many 

members.  Each SIG is a small group whose leader 

prepares material for presentation and encourages 

open discussion and questions.  We urge you to attend 

the SIGs and hope you will find one or more of inter-

est to you.  Ideas for additional groups are welcome, 

as are volunteers to form and lead new SIGs. 

 

Investment Club 

 
Meets the third Saturday of each month at 10 a.m. at 

the 127 S. Senior Center. The leader is Bob Mohar .  

Anyone interested should contact Bob  at 707-0434”. 

 

Pleasant Hill Group 

 
The Pleasant Hill group meetings will be announced 

by the SIG Leader, Dick Riesz. Meetings are held in 

the Pleasant Hill Community House on Main Street 

across from the Pleasant Hill Post Office.  All mem-

bers are welcome and visitors from the Pleasant Hill 

area are especially encouraged to come.  
 

Photography Club 

 
The Photography Club, a PPCUG SIG, meets the 

fourth Thursday of each month at the Fairfield Glade 

Community Church at 1:00PM.  Topics vary each 

month but we show and discuss member's photos 

each month.  One or two "People's Choice" photos 

are submitted to the Glade Vista each month for pub-

lication. The SIG leader is Jim Mansfield.  

 

A photo editing workshop is held at 1PM at the FFG 

Community church on the first Friday or each month. 

 PPCUG Website 
 

Visit our website at www.PPCUGinc.com. The Learn-

ing Center class schedule and Gazette are all 

 available on our web site. 
Send your comments and suggestions to the  

Webmaster, Don Lewis 

Webmaster@ppcuginc.com  (931) 456-5352 

mailto:ambaker@citlink.net
http://find.pcworld.com/71921
http://find.pcworld.com/71921
http://www.pcworld.com/downloads/file/fid,84524/description.html
http://tinyurl.com/6gkf8wx
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 07-18-11 General Meeting Minutes 
 

Prior to the start of the General Meeting Carl Nordeen (past president) took a moment to introduce the new 

officers of the club who were beginning their service to the organization. 

 

The question and answer period began with a member stating that his computer was locked up with the in-

ability to do anything since receiving a “security warning” message. Through further investigation it was de-

termined that he had a serious virus problem best addressed by applying the procedures conveniently located 

in the July edition of the Gazette newsletter article, How to Remove “Rogue Anti-Virus”.  

 

Carl listed several sites that are helpful and dependable to be used for research, program downloads and help 

with various problems encountered in our daily use of computers. Sites such as “bleepingcomputer.com, my-

wot.com, malwarebytes.org, Superantispyware.com,  Ccleaner.com, FileHippo.com and Piriform.com” were 

suggested for their safety and value. Mention was made that all of these and others have been written about 

previously in club literature and Links to them were available on our website in the past. Don Lewis webmas-

ter, was asked to see if these links could be restored on the current website.  

 

Management of “cookies” was discussed in response to member questions. Carl demonstrated how using 

Ccleaner.com/Options/cookies, was a very easy method of handling “cookie” issues. 

 

A very short business meeting was called to order after the break by President Steve Rosenstein. Steve gave 

an overview of the club, its' subgroups, library assets, upcoming programs and in general the reasons and 

benefits of the club to its' members. Current membership was stated as approximately 145. A number of 

guests were recognized at today’s meeting. As required, the proposed next year’s budget had been presented 

to the board at its' July meeting and it was accepted.  Copies of the budget were made available to any mem-

ber requesting access.  One member who had a particular need for a “floppy” drive was referred to Bob 

Willis who offered to help find one after the meeting.  

 

Steve then turned the meeting over to Alan Baker for today’s program on YouTube. Alan provided a handout 

(Improving Your Videos) also available on the club website. A brief history of the YouTube company was 

given showing its' extremely rapid rise from an idea in Feb. 05 to a sale to Google in Oct. 06 for the amazing 

sum of $1.65 billion.   

 

YouTube is a site for sharing videos. Channels allow for grouping videos of similar material. YouTube does 

censor all videos presented but the standard used MAY not be YOUR standard. Videos can be located by 

searching Google/videos or directly to the YouTube site and specifying what you are looking for. Each video 

comes with “toolbar” commands at the bottom of the video screen. Videos can be viewed without an account 

being created but an account allows greater interactivity. Uploading your videos,  subscriptions, play lists, 

comments, tags, etc. require establishing an account which is free and easy.  

 

It is recommended that videos be edited with Window Movie Maker or similar software prior to uploading. 

Also recommended is carefully choosing wording of your search entry to provide best results. Tutorials are 

available on site. Interest was expressed in a follow-on YouTube program for those interested in more You-

Tube familiarization. Alan will announce the format and timing of an additional YouTube program.  

 

Door Prize drawings for 4GB Flash drives were won by Jean Del Frate and Steve Rosenstein.  
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Easy and Fast Way to Update or Install Free Software 
by Ira Wilsker 

  

WEBSITES: 

http://ninite.com 

http://ninite.com/linux 

http://allmyapps.com 

http://www.techsupportalert.com/content/quick-way-install-dozens-free-apps.htm             

A regular reader of this column suggested that I write about a free service that can automatically install and update 

the most popular freeware programs available.  She recommended Ninite, but I was also familiar with a competitive 

service from AllMyApps. While both have comprehensive listings of free software, AllMyApps also includes links 

to some commercial software applications, so I would have to give the edge to Ninite when it comes to the mass in-

stallation of free software. 

             

San Francisco based Ninite (ninite.com) offers about 85 of the most widely used free Windows programs which can 

be selectively installed without any intervention by the user once the programs have been selected from the Ninite 

list.  To implement the Ninite service, the user simply checks the software titles desired, and downloads the small 

installer that automates the install process.  The automated installer installs all of the selected programs without any 

intervention; there is no "next" to click, and questionable optional items, such as toolbars, are automatically refused 

during the installation process. The freeware files downloaded and installed by Ninite are always up to date with the 

latest versions available.  What is especially helpful and useful is that the single installer which is downloaded re-

members which programs were selected, and rerunning the installer which was originally downloaded will automati-

cally check for the latest versions and updates, and install them; there is no need to re-download a new installer 

unless additional programs are selected, or previously selected programs are no longer desired.  The Ninite installer 

can identify the operating system of the computer, and intelligently install 32 or 64-bit versions as appropri-

ate.  Since most of the freeware programs are multi-lingual, the programs offer a selection of languages during the 

install process; Ninite will identify the chosen language on the computer, and install the software with the correct 

language option.             

It is not necessary to create an account on the Ninite website, and no signup is required to make full use of the ser-

vices.  For business and other commercial users with a large number of computers to maintain, Ninite offers a "Pro" 

version for a mere 20 cents per computer per month, which will transparently maintain the free programs on the cov-

ered computers, but the Pro version is not necessary for home users who use the free installer. 

            

 The Ninite website at ninite.com  is very intuitive and easy to use; the page is divided up into categories of free 

software, and all the user needs to do is check the box adjacent to the selected programs, and then download the cus-

tomized installer at the bottom of the page.  The downloaded installer does all of the work with no intervention re-

quired of the user.  The categories of free software available on the Ninite website are Web Browsers, Messaging, 

Media, Runtimes, Imaging, Documents, Security, File Sharing, Other, Utilities, Compression and Developer Tools; 

each category contains from two to fifteen programs, all selectable by check box.             

For those who would like to try or use multiple internet browsers, Ninite offers Google's Chrome, Firefox, Apple's 

Safari and Opera.  As with all Ninite categories, any one, any combination, or all can be automatically downloaded 

and installed with the Ninite installer.  As stated earlier, that same installer can be rerun to automate the update proc-

ess, insuring that the user is getting the latest updates and versions available.  Similar Ninite service is available for 

all of the other categories listed.  Many people use a variety of messaging, and Ninite can selectively install any or 
(Continued on page 6) 

http://ninite.com/
http://ninite.com/linux
http://allmyapps.com/
http://www.techsupportalert.com/content/quick-way-install-dozens-free-apps.htm
http://ninite.com/
http://ninite.com/


Gazette —  August 2011                                        www.PPCUGinc.com                                                        Page 6 

 

 

all of several messaging products including Skype (Internet Telephone), Windows Live Messenger, Pidgin (supports 

multiple instant messaging clients), Digsby (supports multiple instant messaging clients), Google Talk, Thunderbird 

Email Reader, AIM (AOL Instant Messenger) and the Yahoo! IM Client. The media category includes 15 media 

utilities, including iTunes, Hulu (internet TV), VLC (most widely used video and audio player which plays almost 

all known formats), Winamp, and QuickTime. 

             

Ninite can help to keep the popular "runtimes" (programs used to run other programs) up to date on the users' com-

puter, and include such runtimes as Java, Flash, Silverlight, and .Net.  Anyone who may need to view or edit digital 

images in a variety of formats can select Microsoft's Paint.NET, Google's Picasa, GIMP, IrfanView (my personal 

favorite that can also play all video and audio files with the "AllPlugIns" option) and a variety of other image editors 

and viewers.  People often find that they need a multiplicity of document utilities in order to open, view or edit a va-

riety of documents, and Ninite obliges by offering a wide assortment of document software.  Among the selection 

are a trial version of Microsoft Office 2007, OpenOffice (reads and writes almost all office documents, including 

Microsoft office), LibreOffice (my choice that can (read and write almost all office documents, including Microsoft 

office), and several PDF writers that can create PDF documents from almost any program that can print files.             

Readers of this column may be aware that I am tenacious about security, and have layered security on all of my 

computers.  The selection of free security software included on Ninite are among the most popular available, and 

includes Microsoft Security essentials, Avast, AVG, MalwareBytes (on every computer that I use), Ad-Aware, Spy-

bot Search and Destroy, and SuperAntispyware (my favorite and on every computer that I use).  Users who are en-

gaged in file sharing (a possibly dangerous online activity) may find that uTorrent and eMule will serve them 

well.  The "Other" category on Ninite includes several miscellaneous but useful free utilities including Dropbox 

(online backup and file sync utility), Evernote (online notes), Google Earth, password managers, file search utilities, 

and the  Mozy online backup service.  Ninite offers 16 assorted utilities, including the very popular CCleaner (disk 

cleaner with additional utilities), Defraggler (hard drive defragmenting), Recuva (file undelete and recovery), Revo 

Uninstaller, Glary System Utilities (comprehensive computer maintenance tools) ninite.com/linux and several other 

useful utilities.             

While recent versions of Windows can handle the common "zip" compressed file format, there are many other com-

pression formats in wide use that Windows cannot natively process.  Ninite offers 7-Zip (a popular free compres-

sion/decompression utility that can handle almost all compression formats), and a trial version of the commercial 

WinZip.  Other useful free utilities available in the Ninite "Developer Tools" category are programming tools, 

FileZilla (FTP client), Notepad++ (text editor that can open and edit many file formats), and some other utilities. 

             

Ninite is not just for Windows, as it has a similar listing of 17 free programs for those using the Linux operating sys-

tem, at ninite.com/linux.  Just like the Windows version, checking the boxes and downloading the installer simpli-

fies and automates the software installation process for Linux users.             

With a fine, free, service like Ninite, it is easy for any PC or Linux user to have the most popular free software pro-

grams on his computer, and keep them updated.  Thanks Ninite! 

  

(Continued from page 5) 

http://paint.net/
http://ninite.com/linux
http://ninite.com/linux
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Tips & Tricks | Tutorial 

Better File Information with Windows Explorer 
 

Sort your files more intelligently with a few simple clicks. 

By Les Townsing, a member of the Melbourne PCUG, Australia 

April 2011 issue, PC UPDATE 

www.melbpc.org.au 

editor (at) melbpc.org.au 

 

There is often a lot of information automatically recorded when you save a file. This information can be easily dis-

played and can prove to be useful when sorting/categorizing files. 

 

Normally, when you open Windows Explorer (right-click on the Start button and select ‗Explore‘) you get displays 

indicating the file name, size, date modified, and other general information (see below). 

 

If, however, we right-click anywhere on the Column Heading bar we get a lot of additional columns we can add. 

Depending on the type of files you can select some meaningful columns. If we are looking at picture files (jpg) some 

appropriate columns may be Date Taken, Dimensions or file size. 

 

If you right-click on a file and select properties, you get to view all the possible information as well as the ability to 

edit some of the fields. 

 

You can now sort your files by any of the columns (just left click on the column heading). 

 

If we right-click on a file, we can select Rename and change the name to a more meaningful title rather than a bunch 

of numbers. These features may be more meaningful if we use music files as an example. 

 

Unfortunately, some of the ―Ripper‖ programs (programs that copy CDs and often convert the files to MP3s) get it 

wrong or leave a lot of stuff out, which can be quite annoying, particularly if it is the artist‘s name or the title of the 

song. 

 

When selecting a CD Ripper program this is one item worth checking. 

 

Extra Tip 

If you select a file (click on it) then hold down the shift key whilst clicking on another file then the system will se-

lect all the files in between and including the first and last file you clicked on. Now, if you right-click on any one of 

the selected files and choose properties, you can edit a field for all the selected files. This is no good for titles as 

every file must have a different name. However, it is good when you want to edit the album title or artist for a num-

ber of tracks. 

 

Extra Extra Tip 

Often the files you want to select are not consecutive in a list. No problem, hold down the control key then click on 

the files you want. As you click on the files they become marked as selected. You can then right-click on any se-

lected file to edit the properties of all the selected files. 
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Cyber Security Tip ST08-001 – Using Caution with USB Drives 
 

Author: Mindi McDowell 

Produced 2008, 2011 by US-CERT, a government organization. 

http://www.us-cert.gov/cas/tips/STYY-XXX.html 

 

Note: This tip was previously published and is being re-distributed to increase awareness. 

 

USB drives are popular for storing and transporting data, but some of the characteristics that make them convenient 

also introduce security risks. What security risks are associated with USB drives? 

 

Because USB drives, sometimes known as thumb drives, are small, readily available, inexpensive, and extremely 

portable, they are popular for storing and transporting files from one computer to another. However, these same 

characteristics make them appealing to attackers. 

 

One option is for attackers to use your USB drive to infect other computers. An attacker might infect a computer 

with malicious code, or malware, that can detect when a USB drive is plugged into a computer. The malware then 

downloads malicious code onto the drive. When the USB drive is plugged into another computer, the malware in-

fects that computer. 

 

Some attackers have also targeted electronic devices directly, infecting items such as electronic picture frames and 

USB drives during production. When users buy the infected products and plug them into their computers, malware 

is installed on their computers. 

 

Attackers may also use their USB drives to steal information directly from a computer. If an attacker can physically 

access a computer, he or she can download sensitive information directly onto a USB drive. Even computers that 

have been turned off may be vulnerable, because a computer‘s memory is still active for several minutes without 

power. If an attacker can plug a USB drive into the computer during that time, he or she can quickly reboot the sys-

tem from the USB drive and copy the computer‘s memory, including passwords,  encryption keys, and other sensi-

tive data, onto the drive. Victims may not even realize that their computers were attacked. 

 

The most obvious security risk for USB drives, though, is that they are easily lost or stolen (see Protecting Portable 

Devices: Physical Security for more information). If the data was not backed up, the loss of a USB drive can mean 

hours of lost work and the potential that the information cannot be replicated. And if the information on the drive is 

not encrypted, anyone who has the USB drive can access all of the data on it. 

 

How can you protect your data? There are steps you can take to protect the data on your USB drive and on any com-

puter that you might plug the drive into: 

 

* Take advantage of security features – Use passwords and encryption on your USB drive to protect your data, and 

make sure that you have the information  backed  up in case your drive is lost (see Protecting Portable Devices: Data 

Security for more information). 

 

* Keep personal and business USB drives separate – Do not use personal USB drives on computers owned by your 

organization, and do not plug USB drives containing corporate information into your personal computer. 

 

* Use and maintain security software, and keep all software up to date - Use a firewall, anti-virus software, and anti-

spyware software to make your computer less vulnerable to attacks, and make sure to keep the virus definitions cur-
(Continued on page 9) 

http://www.us-cert.gov/cas/tips/STYY-XXX.html
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rent (see Understanding Firewalls, Understanding Anti-Virus Software, and Recognizing and Avoiding Spyware for 

more information). Also, keep the software on your computer up to date by applying any necessary patches (see Un-

derstanding Patches for more information). 

 

* Do not plug an unknown USB drive into your computer – If you find a USB drive, give it to the appropriate au-

thorities (a location‘s security personnel, your organization‘s IT department, etc.). Do not plug it into your computer 

to view the contents or to try to identify the owner. 

 

* Disable Autorun – The Autorun feature causes removable media such as CDs, DVDs, and USB drives to open 

automatically when they are inserted into a drive. By disabling Autorun, you can prevent malicious code on an in-

fected USB drive from opening automatically. In How to disable the Autorun functionality in Windows, Microsoft 

has provided a wizard to disable Autorun. In the ―More Information‖ section, look for the Microsoft Fix it icon un-

der the heading ―How to disable or enable all Autorun features in Windows 7 and other operating systems.‖ 
 

Google Raises Ante in Browser Wars with Chrome 12 
 

by Ira Wilsker 

 

WEBSITES: 

http://www.google.com/chrome 

http://www.google.com/support/chrome/bin/answer.py?answer=96817 

http://www.google.com/chrome/intl/en/make/features.html 

http://chrome.google.com/webstore 

  

Worthy competition from strong competitors is good for the consumer.  In the heavily fought browser wars, Firefox 

4 has been closing the gap with the current industry leader Internet Explorer, partially since the new and improved 

Internet Explorer (IE) 9 is incompatible with Windows XP, while Firefox 4 will run on almost all platforms.  Not to 

be lost in the race for browser supremacy is Google, which recently released version 12 of its popular Chrome 

browser.  Chrome has developed a large and loyal following of users, many of whom have sworn off (and swear at) 

Internet Explorer, and to a lesser extent, Firefox. 

  

With Internet Explorer factory installed on all Windows computers in the U.S., it has a built in near-monopoly status 

with new users, and those users who are unaware or unwilling to try a new browser.  Even among novices, Google is 

well known as the premier search engine, even being thought of generically when it comes to internet searches.  

Since so many users of all experience levels use Google, it is inevitable that many of them have seen the advertising 

for Google's entry in the crowded browser field, and many of those have downloaded Google's Chrome browser.  As 

with almost all other browsers available, Google is free to download and use. 

  

Some may rhetorically ask, "Why Chrome?"  The answer is that it is free, will not interfere with any other installed 

browsers, runs on all recent versions of Windows (XP, Vista, and Windows 7), installs very quickly, is arguably one 

of the fastest browsers when it comes to displaying web pages, offers search direct from the address bar, and has 

thousands of third-party applications (known as "apps") available to customize the browser.  On my Windows 7-64 

computer, the Chrome installer was only a 576k download, which installed the browser on my computer in a matter 

of seconds. 

  

A warning about the install process may be in order; on the download page for Chrome are a pair of checkboxes that 

the user needs to be aware of.  One checkbox, if checked, will make Chrome the default browser, meaning that 

Chrome will be opened automatically if a browser is called from the computer or an application.  Another checkbox 

(Continued from page 8) 

(Continued on page 10) 
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says, "Help make Google Chrome better by automatically sending usage statistics and crash reports to Google."  

While the usage statistic reports are relatively safe in terms of personal privacy, because no personal information is 

collected, a crash report that is automatically sent to Google may contain personal information.  Google explains 

this: "Usage statistics contain aggregated information such as preferences, button clicks, and memory usage. It does 

not include web page URLs or any personal information. Crash reports contain system information at the time of the 

crash, and may contain web page URLs or personal information <emphasis added>, depending on what was hap-

pening at the time of the crash."   My personal choice is to not check either of the boxes, as it is easy to reconfigure 

the "Options" in Chrome after it is installed.  One minor issue occurred when installing Chrome; it attempted to 

place a "Google Updater" in my start-up list, which would have run the update utility whenever the computer was 

booted.  Most users will never notice the slight drag on boot time and performance that Google Updater causes, and 

it will keep Chrome (and any other installed Google products) up to date.  My preference is to minimize any pro-

grams that load at boot, and to manually check for updates. 

  

There are several powerful reasons why users should consider using Chrome rather than Internet Explorer as the 

browser of choice.  In my experience, the browser is the most commonly used program on the computer, and a good, 

fast browser can really enhance the computing experience; Chrome can fill that need.  Both the published speed 

comparisons and my own experiences have demonstrated that Chrome is much faster at displaying web pages than 

Internet Explorer, including the new IE 9.  Chrome loads quickly, much faster than Internet Explorer, as it is a 

smaller footprint to load.  Web based applications (apps) also load and run faster on Chrome than IE.  The web has 

become a primary vector to infect or hijack computers, and Chrome offers very good protection from many of the 

forms of web attack.  Chrome utilizes what is called a "sandbox", or a mini-virtual computer and virtual hard drive 

to open web pages or run many web based apps, such that most potential malware carried by websites or online apps 

will not take over the computer.  The Chrome "Safe Browsing" feature warns against websites that may contain mal-

ware, or are suspected phishing (identity theft) websites.  If such a website is detected, the browser window turns 

red, and posts a stern warning about the website.  Chrome has one of the cleanest, uncluttered desktops in the 

browser industry; almost all of the desktop is available to display web content.  While most other browsers have one 

box for internet addresses (URLs) and another box for searches, Chrome utilizes a single bar that serves both func-

tions. 

  

Google offers the "Chrome Web Store" where there are thousands of both free and paid applications, themes, and 

extensions for Chrome.  The apps are categorized into 10 areas, including such subjects as entertainment, games, 

news and weather, shopping, utilities, social networking, and other subjects.  Extensions are small utilities that work 

with Chrome to enhance its functionality or add additional features.  There are hundreds of "Themes" that can be 

used to change the appearance of Chrome.  One of the most popular themes is "Porsche" which has been 

downloaded and installed over a million times, and includes images of the Porsche 911 series, the Boxster Cayman 

mid-engine sports car, the Cayenne SUV, and the Panamera. 

  

I am frequently asked on my radio show about the wisdom of having more than one browser installed, and  it may 

be a good idea to do precisely that.  On every computer owned by my family I have installed Internet Explorer 

(latest compatible version, mostly IE 9), Firefox 4, and the new Chrome 12 (some computers also have Opera and 

the Windows version of Apple's Safari installed).  By having multiple browsers installed, the user can try them all, 

compare them, and decide which one to use as the default or predominant browser.  Many users who have multiple 

browsers available have chosen not to use Microsoft Internet Explorer, as all of the other browsers have some ad-

vantages over the ubiquitous IE, mostly in the areas of speed and security.  For many users Google's Chrome has 

become and remains the browser of choice. 

(Continued from page 9) 
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How Solar-powered Tables Will Wirelessly Charge up Your Units? 
By Dr Zara Wendy Dobson    

 

So there's this very new craze working along side our attraction with the best wireless gizmos [1], and it's the proper 

way to maintain their electric batteries completely full. With most of the newer pads and tablets, smartphones, and 

notebooks, the only common hassle is the most practical alternative to maintain them powered. I started off ques-

tioning whatever I would undoubtedly do with some of these various gizmos and now I ask myself what I'd do with 

out them. I additionally worry every night whether I have each one of them on their proper wiring and charging up 

for the day ahead. 

   

When the techie gadgets firstly hit the marketplace there were cables wired with the Universal serial bus slots on the 

pc. This was like a really fresh approach for me in the first place. I was a lover of the benefit that one could clearly 

connect the unit in at nighttime while verifying e-mail. However, like several things, this quickly became a problem. 

How can I get my gadget with me around the house if it needs to remain connected at the computer? 

   

Soon followed the Universal serial bus wall adapter. I went hunting for one of these soon immediately after my first 

smart phone decision. I needed to plug it in to the wall in my bedroom so that I could have it with me at nighttime, 

however I did not have anything but the Universal serial bus charging cable to power up it. The next thing I was 

aware of, the wall adapter was coming with many of the devices I purchased.  

  

During the last couple of years, I have started to browse and notice important things about wire less charging mats. 

From what I saw at first, they were requiring specific cases for the units to employ them. Fairly recently, this was 

eliminated. The world of wireless recharging is getting ready to bust wide open. 

   

We have to put a pin in that field. We'll be back soon. Right at this moment, we must discuss the importance of eco-

friendly technology [2]. Various naysayers to earth-friendly technology will suggest it's tree-hugging talk to get con-

sumers to get higher priced items and that it's all an absurd attempt due to the fact none of the adverse consequences 

are essentially taking effect. Even if that is a fact, the primarily headache with that factor is what number of men and 

women are in the globe. Because of the number of people living on the world and the amount of them using coal and 

natural gas driven electricity, we have started to have a complication. Now reflect on the number of them that will 

have kids and precisely how that will multiply the sum of individuals consuming electrical energy and standard fu-

els. The ideal conscientious thing to undertake is for hi-tech to feature natural green choices currently that can be-

come green needs subsequently [3]. 

   

With that in mind, ladies and gentleman, I present to you the earliest alternative system to charge up wifi all your 

cellular units, Panasonic's brand new solar-powered wi-fi charging table. Due to be introduced at the end of 2011 or 

early 2012, the modern table will use solar power generated by the panels on the face of the table to charge the units 

positioned on the table! This could be the potential future of a natural green solar technology that is Qi enabled. 

   

Exactly what is Qi you ask? Qi has been created by the wire less power consortium as a default specification to be 

employed by the makers of charging gadgets, like our brand new table, and the items which they will charge up, 

much like your brand new smartphone that is touchscreen technology equipped, reads guides and has a foldout full-

sized key board. This contemporary Qi technological innovation has only been known since the beginning of this 

season, but everyone is thinking swift integration and a score of device releases. Utilizing Qi with older wireless 

units is self-assured, and we will absolutely be hearing more details on Panasonic's most recent solar-powered wire 

less charging table and several other Qi enabled rechargers in the near future.  

   

If you feel the need to explore more about solar panel technology and the ways to add it in your daily life I'd like to 
(Continued on page 12) 



Gazette —  August 2011                                        www.PPCUGinc.com                                                        Page 12 

 

 

indicate you these other solutions: 

   

- [1] Here you can check out more in detail the info relating to the photovoltaic table. Geek.com is a web site that 

targets technology media postings with discussion. It was the first to document the news reports about the <a 

href="http://www.geek.com/articles/gadgets/panasonics-solar-powered-table-wirelessly-charges-your-gadgets-

20110520/">Panasonic's photovoltaic table</a>.  

   

- [2] Here you will have a clear analysis on how to use solar powered energy to power most unit's electric batteries 

(i.e. mobile, car batteries, etc...). If you are not able to spend the money for the expense to connect a home solar en-

ergy system, it could be a very good 1st step to introduce you to solar power systems. 12voltsolarpanels.net is a 

completely free blog site monitored by Hettie that gives her experiences to help individuals make the move from a 

full-time energy dependency to a productive energy efficiency. She shows some good tips about <a href="http://

www.12voltsolarpanels.net/rv-solar-panels-101-ultimate-guide-12-volt-battery-charging">rv solar battery charger</

a> to help motorhome owners charge up their batteries and realize how a solar panel works to extend the use of solar 

energy panels in their properties and other products.  

   

- [3] If you possibly can pay the cost to setup residential solar panels on your home (or are eligible for solar tax 

credits or incentives), here a few content pieces to help you see how solar energy panels work and ways to include 

them in your life. Residentialsolarpanels.org is a non-profits web site managed by Shannon. She is a freelance pub-

lisher and expert on photo-voltaic for domestic use. If you plan to learn more about solar energy panels I propose 

you to evaluate the following information regarding <a href="http://www.residentialsolarpanels.org/">solar residen-

tial systems</a>. 

 

About me: 

Dr Zara Wendy Dobson (http://twitter.com/dr_zara_dobson) is a former post doctoral researcher at the Institute of 

Informatics, University of Edinburgh, Scotland. She obtained a diploma in computing science and technology, and 

extended her research project into a Ph.D. working in the Bio Medical and Multimedia Information Tech for the 

University of Sydney, Australia. She is a writer for many leading magazines in the renewable energy sector i.e. 

"Renewable Energy World". Actually she is a guest writer for renewable energy websites, blogs and boards. 
 

 

(Continued from page 11) 
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Good Fences Make Good Desktops (Apologies to Robert Frost) 
 

By Joe Asling, Columnist, Monterey Bay Users Group – PC, California 

June 2011 issue, mbug-pc newsletter 

www.mbug.org 

Jhasling (at) comcast.net 

 

I like a neat desktop. In XP, I would right-click on the desktop to get a context menu, then click  New/Folder and 

name it ―Internet‖ or ―Utilities‖ or whatever. I would open it and fill it with shortcuts to all the applicable programs. 

This way, any program (or other file) I needed was two double-clicks away. But in Windows 7, when you create a 

new folder, it is a nasty double-columned Windows Explorer folder, and if you accidentally click in the left column, 

you lose all your nice shortcuts (you can get them back with the left arrow in the upper corner, but...). So I needed 

another way to organize icons. 

 

Now, the Start Menu in W7 is an improvement. You can right-click on any program icon and select ―pin to Start 

Menu‖ or ―pin to toolbar.‖ 

 

The programs you use all the time (Internet browser, mail client) can sit on the toolbar and be up in one click, and 

programs you use frequently are a click of the Start button (the circle with the windows flag in the lower left-hand 

corner) away. You can customize how the Start menu and the toolbar look by right clicking on the toolbar or Start 

button and clicking on ―Properties.‖ 

 

The best thing about the W7 Start Menu is that each program you have used has a little right-pointing arrow at the 

right side; hover the mouse arrow over it and you will see, and can open, the files you have recently opened with 

that program–admirable! 

 

OK, now to the fences. There are files I don‘t use all the time (backup program, scanner software, manuals for hard-

ware I haven‘t played with a lot yet) but don‘t want to go digging for in Windows Explorer. Stardock makes a free 

program called ―Fences‖ http://www.stardock.com/products/fences/). 

 

Essentially, it creates shaded areas on the desktop into which you can drag shortcuts, just like with XP‘s folders. 

When you first install it, there are some wizards you can use to configure your fenced areas, or you can just go free-

form. You can name them, resize them, and move them. You cannot minimize them as you could folders in XP, but

–almost as good–just double-click on the desktop, and voilà, they disappear. Double-click again and, voilà, they 

come back. (Curiously, other desktop icons, such as the Recycle Bin, disappear also, but you can right-click on the 

icon and select ―Exclude this Item from Fences‘ quick-hide.‖) You can do a lot of other stuff, like resize icons, from 

the context menu when you right-click on the desktop. So, happy fencing in Windows 7! 
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Working with Page Numbers in Word 2007 
 

By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., FL  

April 2011 issue, Sarasota PC Monitor 

www.spcug.org 

ndemarte (at) Verizon.net 

 

Adding page numbers to a document seems like a simple task. You open your document, position the cursor, and, on 

the Insert tab in the Header and Footer group, click Page Number. But Word offers several customizations for this 

process. It all depends on where you want your page numbers to appear and how you want them to look. 

 

Inserting Page Numbers 

Your first decision is where you want to position the page number: in a header, footer, or in the margin. The most 

common place is in a footer. Fortunately, the Footer gallery has many footers which include page numbers. Click 

the Insert tab, then Footer, and scroll to see the gallery choices. Click a design to make it your footer.  

 

If you find a footer you like which does not include a page number, it is possible, although not easy, to add a page 

number to the footer. To do this, insert your footer choice and double click the footer area to select it. You will no-

tice that a Header and Footer Tools tab appears above the Ribbon whenever a header or footer is selected. Put your 

cursor in the footer where you want the page number to appear. Because many of these gallery footers contain ta-

bles, you may have to press Ctrl+tab to set a tab stop within the table cell in order to put your cursor exactly where 

you want it.  

 

Once the cursor is set, under Header and Footer tools, click Page Number. Click 

"Current position" which opens the Number Style gallery. Click a design for 

your number from the gallery, and it will appear in the footer. Warning: If you 

choose an option other than "Current position," such as "Bottom of the page," 

the page number will replace the footer instead of adding to it.  

 

An easier approach is to insert the page number first, and then add other ele-

ments and information to your footer. To do this, on the Insert tab, in the 

Header and Footer group, click Page Number. Choose "Bottom of the page," then click a number style from the list, 

making sure the design puts the page number in the area of the footer where you want it to appear (left, center or 

right). To insert content after the page number in the footer, press the End key, then the Tab key. Then enter the con-

tent, such as author's name or date. You may need to use the Tab key to adjust the position of content items. 

 

Formatting Page Numbers 

Office 2007 is full of new galleries, which are collections of preformatted content which can be added to a document 

with a single click. To see the page number gallery of styles, start with a document that does not contain page num-

bers. On the Insert tab, click Page Number and then one of positions, such as "Top of the Page." A gallery opens that 

shows page numbers in various positions on the page. Some include graphical elements, others text, such as "Page X 

of Y," as in Page 3 of 14. More options can be found in the Building Blocks Organizer. Click the Insert tab -- Quick 

Parts -- Building Blocks Organizer and scroll to the Page Number gallery. 

 

To change the actual number type, such as from numeric to Roman numerals, click the Page Number icon and select 

"Format Page Numbers." Choose the style you want from the drop down list. 

 

Of course, you can always select just the page number and format it yourself. Double click in the area where you've 
(Continued on page 15) 
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put the number, then select the page number to reveal a mini-toolbar just above it. Here you can easily change the 

font and apply attributes such as color, boldface, or italics. To change the size of the number using the mini-toolbar, 

either click the large or small capital A icon, which grows or shrinks the selected number, or change the font size 

number. The new format is copied immediately to all other page numbers in the document. 

 

Removing Page Numbers 

The easiest way to remove all page numbers in a document is to select one of them and press the Delete key. If you 

have created a footer which includes a page number and other content, the content will remain even if the page num-

ber is deleted.  

 

Managing Page Numbers 

Often you will not want a page number to appear on the first page, which might be a cover sheet or title page. It isn't 

difficult to remove the page number from the first page, but don't just delete the number 1. This will cause all the 

other page numbers to disappear as well. Instead, remove the first page number using the "Different first page" com-

mand. Let's say you have added a footer which contains the author's name and the page number. Double click in the 

footer area of the first page, which opens the Header and Footer Tools tab. Click to put a checkmark next to 

"Different first page" in the Options group. Your footer and page number will be removed from the first page. The 

second page will contain the footer and page number 2. You can now insert a footer that does not include a page 

number on the first page, if you wish, without changing the numbering on the rest of the pages. 

 

If you want the first page to be unnumbered, but the second 

page to display page number 1, insert a footer with page num-

bers in the document, then double click in the footer area of the 

first page. Under Header and Footer Tools, select "Different 

First Page." Then click Page Number -- Format Page Numbers. 

In the "Start at" box, type 0, and then click OK. 

 

It is also possible to change the numbering style or format in 

different sections or chapters of a book or long document. A 

section within a long document can, for instance, include no 

page numbers, even though the surrounding sections are num-

bered. 

 

Working with page numbers is just one example of the depth of 

options available within Microsoft Office programs. The more 

you become familiar with the options and how to use them, the 

closer you will come to fully utilizing these programs. 

 

 

 

   

(Continued from page 14) 



PLATEAU PC USERS GROUP, INC. 

APPLICATION FOR MEMBERSHIP 

Return this application, with check for annual dues ($25 family, $20 individual, $10 student membership) payable to 
"PLATEAU PC USERS GROUP." Return to the club Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 

3787, Crossville, TN 38557. 

________________________      

Date                                                     

________________________    ____________________     ________________________________________________ 

Last Name                                   First Name                                 Family Members (if family membership) 

_________________________________________________   _________   _____________________________________________ 
Address: City                                                           State      Zip Code     Phone Number 
_________________________________________ 
E-Mail address 

l have used PCs since (year):                I have belonged to a Computer Club before. Yes                No 

I have knowledge in the following areas and would be willing to share my knowledge with club members: 

________________________________________________________________________________________________________ 

September 2011 

Sun Mon Tue Wed Thu Fri Sat 

    1 2  

1 PM Photo 

Editing 

Workshop 

3 

4 5 6 7 8 9 10 

11 12 13 14   2 pm 
Board Mtg 

15 16 17   10 am 

Investment SIG 

18 19    6 pm 

Q & A Session 

Followed by 

General Mtg 

20 21 22  1 pm 

Photography 

Club Mtg 

23 24 

25 26 27 28 29 30  


